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Human Resources 9.1 Payroll Reporting - HCSD 

Crystal Reports 

W-2 Reprint 
W2 reprint information may be printed and mailed, or handed, to the current/former employee. 

W2 reprint information should never be emailed, faxed, or given to anyone other than the 

current/former employee.  

Procedure 

 
In this topic you will learn how to run the W-2 Reprint report.  

 
 

Step Action 

1. Double-click the PS9.1 Launcher button. 
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Step Action 

2. Click the button to the right of the Database field. 

 

3. Click the PS 9 Higher Ed Reports (PS9HERPT) list item. 

 

4. Click the button to the right of the Application field. 

 

5. Click the Crystal Reports list item. 
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Step Action 

6. The navigation to access Crystal reports on the V:\ is as follows: 

 

V:\PeopleSoft > HRMS > End User Reports and Procedures > 9.1 LSU Crystal 

Reports 

 

Select the appropriate file or folder from the list provided. 

7. NOTE: Make sure the "keep launcher open when running report" option is 

selected before browsing for files and folders. 

8. Click the Browse button. 
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Step Action 

9. Double-click the Payroll Folder list item. 

 

10. Double-click the W2_Reprint_new option. 

 

11. Click the Start button. 

 

12. This warning message will display when opening any Crystal report. 

 

Click the OK button. 

 

13. Click the OK button. 
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Step Action 

14. Click the Refresh button. 

 

15. Enter your PeopleSoft password. 

16. Click the OK button. 
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Step Action 

17. Enter the desired information into the EMPLID field. Enter "7 - digit Employee ID 

Number". 

18. Enter the desired information into the COMPANY field. Enter "003". 

19. Enter the desired information into the CALENDAR_YEAR field. Enter "2011". 

20. Click the OK button. 
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Step Action 

21. The printer icon may be used to print the W2. 

 

NOTE: W-2s should not be saved to your desktop. W-2s will be either mailed or 

handed to the employee. W-2s should never be emailed or faxed. 

22. Click the Refresh button to print another W-2, or click the X (not the red X) at the 

top right of the page to close the W-2. 

 

23. Click the OK button. 

 

24. This completes W-2 Reprint. 

End of Procedure. 
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Leave Accrual Report 

Procedure 

 
In this topic you will learn how to run the Leave Accrual Report. 

 
 

Step Action 

1. Click the Browse button. 
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Step Action 

2. Click the Web Address button. 

 

3. Click the 9.1 LSU Crystal Reports list item. 

4. Click the Down button of the scrollbar. 
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Step Action 

5. Click the LSU_LEAVE_ACCRUAL 9 list item. 

 

6. Click the Open button. 

 

7. Click the Start button. 

 

8. Click the OK button. 

 

9. Click the OK button. 
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Step Action 

10. Click the Refresh button to run a new report. 

 

11. Enter your PeopleSoft password. 

12. Click the OK button. 
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Step Action 

13. Click the button to the right of the Business Unit field or type the Business Unit 

directly into the field. 
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Step Action 

14. Click the Appropriate Business Unit list item. 

 

NOTE: For training purposes only EKLMC will be used as the BU for this 

example. 

 

15. Click the OK button. 

 

16. Click the button to the right of the Accrual Process Date field. 

 

NOTE: The Accrual Process Date is the last day of the pay period. 

 

17. Click the desired date. For this example 05/27/2012 will be used as the Accrual 

Process Date. 

 

18. Click the OK button. 

 

 



 

Training Guide 
Human Resources 9.1 Payroll Reporting - HCSD 

 

 Page 15 

 
 

Step Action 

19. Click the Zoom Level button to view the Zoom dialogue box and resize the page. 

 

NOTE: Employee information has been removed from the Preview pane for 

training purposes only. 

 

20. Click the Fit One Dimension option. 

 

21. Click the OK button. 
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Step Action 

22. You can view additional information by clicking on another department in the 

Groups section.  

23. Click the File option on the tool bar to either save or print the report.  

 

NOTE: Do not use the save icon to save the file. You may use the printer icon to 

print the report. 

24. Click the Refresh button to run another report. 

 

25. Click the OK button. 

 

26. Enter the desired information into the Business Unit field. Enter "WOMMC". 

27. Enter the desired information into the Accrual Process Date field. Enter 

"05/13/2012". 

28. Click the OK button. 
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Step Action 

29. Click the Close button. 

 

30. A warning message displays. 

 

NOTE: ALWAYS click NO or you will overwrite the file.  
 

Click the No button. 

 

31. This completes Leave Accrual Report. 

End of Procedure. 
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K-Time Reports 

Procedure 

 
In this topic you will learn how to run K-Time Reports. 

 
 

Step Action 

1. Double-click the LSU_KTIME_Over_360_9 report. 

 

NOTE: The LSU_KTIME_Over_360_9 will be demonstrated first, followed by the 

LSU_KTIME_1-5_Over_240_9. 

 

2. Click the Start button. 

 

3. Click the OK button. 

 

4. Click the OK button. 
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Step Action 

5. Click the Refresh button. 

 

6. Enter your PeopleSoft password. 

 

Click the OK button. 
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Step Action 

7. Enter the desired information into the Business Unit field. Enter "EKLMC". 

8. Click the button to the right of the Accrual Process Date field. 

 

9. Click the desired date. For this example 05/27/2012 will be used as the Accrual 

Process Date. 

 

10. Click the OK button. 
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Step Action 

11. NOTE: For training purposes the employee name has been hidden in the Design 

section and the Preview pane. 

12. Click the Close button. 

 

13. NOTE: ALWAYS click NO or you will overwrite the file. 
 

Click the NO button. 

 

14. The LSU_KTIME_1-5_Over_240_9 report will now be demonstrated. 

 

Click the Browse button. 
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Step Action 

15. Double-click the LSU_KTIME_1-5_Over_240_9 list item. 

 

16. Click the Start button. 

 

17. Click the OK button. 

 

18. Click the OK button. 
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Step Action 

19. Click the Refresh button. 

 

20. Enter your PeopleSoft password. 

 

Click the OK button. 
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Step Action 

21. Enter the desired information into the field. Enter "EKLMC". 

22. Click the button to the right of the Accrual Process Date field. 

 

23. Click the desired date. For this example 05/27/2012 will be used as the Accrual 

Process Date. 

 

24. Click the OK button. 
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Step Action 

25. Click the Close button. 

 

26. This completes K-Time Reports. 

End of Procedure. 
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Garnishment Report 

Procedure 

 
In this topic you will learn how to run the Garnishment Report. 

 
 

Step Action 

1. Double-click the LSU_PAYROLL_GARNISHMENTS_new9 report. 

 

2. Click the Start button. 

 

3. Click the OK button. 
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Step Action 

4. Click the Refresh button. 

 

5. Enter your PeopleSoft password. 

 

Click the OK button. 
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Step Action 

6. Enter the desired information into the field. Enter "EKLMC". 

7. Click the button to the right of the Paycheck Issue Date field. 

 

8. Click the desired date. In this example the Paycheck Issue Date will be 06/01/2012. 

 

9. Click the OK button. 
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Step Action 

10. For training purposes, the employees name and SSN have been deleted. 

 

Click the Close button. 

 

11. NOTE: ALWAYS click No or you will overwrite the file. 
Click the No button. 

 

12. This completes Garnishment Report. 

End of Procedure. 
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State Group Benefits Report 

Procedure 

 
In this topic you will learn how to run the State Group Benefits Report. 

 
 

Step Action 

1. Double-click the STATE GROUP BENEFIT PS9 at 11-3-10 report. 

 

WARNING: Do not select the STATE GROUP BENEFITS 070705 9 option. No 

results will display suing this option. 

 

2. Click the Start button. 

 

3. Click the OK button. 
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Step Action 

4. Click the Refresh button. 

 

5. Enter your PeopleSoft password. 

 

Click the OK button. 
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Step Action 

6. Enter the desired information into the Business Unit field. Enter "EKLMC". 

7. Click the button to the right of the Paycheck Issue Date 2 field. 

 

8. Click the desired date. For this example the 18th will be used. 

 

9. Click the button to the right of the Paycheck Issue Date field. 

 

10. Click the desired date. For this example the 18th will be used. 

 

11. Click the OK button. 
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Step Action 

12. NOTE: For training purposes the employee name has been hidden in the Design 

section and in the Preview pane. 
 

Click the Close button. 

 

13. NOTE: ALWAYS click No or you will overwrite the file. 
 

Click the No button. 

 

14. This completes State Group Benefits Report. 

End of Procedure. 
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Query Reports 
When running Query reports that require the use of a Run Control ID, you cannot use the same 

Run Control ID to run multiple reports at the same time. Reports should be run one at a time. You 

must wait for the first report to finish running before requesting another report to run.  

HCSD_FTE_HCP_ACTIVE Report 

Procedure 

 
In this topic you will learn how to run the HCSD_FTE_HCP_ACTIVE Report. 

 

Step Action 

1. Click the Main Menu button. 

 

 

 
 

Step Action 

2. Point to the Reporting Tools menu. 

3. Point to the Query menu. 

4. Click the Query Manager menu. 
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Step Action 

5. Enter the desired information into the begins with field. Enter "HCSD". 

6. Click the Search button. 
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Step Action 

7. Public queries can be edited and saved as private queries. Depending on your access, 

it may be helpful to narrow your results. 

  

Click the Edit link for the HCSD_FTE_HCP_ACTIVE query. 
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Step Action 

8. Criteria can be added to narrow the number of results retrieved by the system. In this 

example, you will add a constant value for the Business Unit so that only results for 

the specified BU are retrieved. 

 

Click the Add Criteria button for the Business Unit field. 

 

 



 

Training Guide 
Human Resources 9.1 Payroll Reporting - HCSD 

 

 Page 39 

 
 

Step Action 

9. Enter the desired information into the Constant field. Enter "5 - character Business 

Unit". 

 

NOTE: In this example the EKLMC business unit is used. 

10. Click the OK button. 
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Step Action 

11. NOTE: If you wish to save the change made to the query, you must use the Save 

As link and re-name the query as a private query. 
 

Queries should always be run to HTML format first so that all available rows and 

fields are displayed. 

 

Click the Run tab. 
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Step Action 

12. Enter the desired information into the As Of field. Enter "052712". 

13. Click the OK button. 
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Step Action 

14. Click the Download to Excel link. 

 

This will open a new window. 
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Step Action 

15. Click the Open button. 
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Step Action 

16. Click the Page Layout link. 
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Step Action 

17. The following changes to the spreadsheet will be made in Page Setup: 

• Change page Orientation from Portrait to Landscape; 

• Add Header and Footer information; and 

• Repeat column titles on each page for printing purposes. 

 

Click the Print Titles button. 

 

18. Click the Landscape option. 

 

19. Click the Header/Footer tab. 

 

20. Click the Custom Header button. 

 

21. NOTE: Make sure the cursor is in the appropriate section (e.g. Left section, 

Center section or Right section). 
 

Click the Font button. 

 

22. Click the Bold option. 
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Step Action 

23. Click the OK button. 

 

24. Enter the desired information into the Center Section field. Enter "HPC 

QUARTERLY REPORT". 

25. Click the OK button. 

 

26. Click the Custom Footer button. 

 

27. Click in the Right Section field. 

28. Click the Insert Page Number button. 

 

29. Click the OK button. 

 

30. Click the Sheet tab. 

 

 

  



 

Training Guide 
Human Resources 9.1 Payroll Reporting - HCSD 

 

 Page 47 

 
 

Step Action 

31. Click the Rows to repeat at top button. 

 

32. Click the 2 cell. 
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Step Action 

33. Click the Rows to repeat at top button. 

 

34. The A2 row will be repeated on each page for printing purposes. 

 

NOTE: The column headers will not display on your monitor for each page. 
 

Click the OK button. 

 

35. Click the Office Button. 

 

36. Point to the Print menu. 

37. Click the Print Preview menu. 

 

38. Click the Next Page button. 

 

39. NOTE: The column headers display on all pages of the report. 
 

Click the Close Print Preview button. 
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Step Action 

40. The following changes will be made to the spreadsheet: 

•  Wrap text; 

•  Resize columns; 

•  Change number of decimal places; 

•  Align column headers; 

•  Insert row borders; 

•  Freeze column headers for scrolling; 

•  Sum a column; 

•  Insert a column/row; 

•  Insert column/row header; 

•  Concatenate (merge) columns; 

•  Hide/Unhide columns/rows; and 

•  Print spreadsheet. 

41. Click the Home tab. 

 

 

 
 

Step Action 

42. Wrap Text 
Highlight the A1 - G2 cells. 
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Step Action 

43. Click the Wrap Text button. 
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Step Action 

44. Resize Columns 
Change the width of the column using your mouse. 

 

Point to the border between columns A and B. 

45. Press the left mouse button on border line and drag the mouse left until column is 

desired width. 

46. Change the width of the column using the Format option. 

 

Click the C cell to highlight the entire column. 

 

47. Click the button to the right of the Format field. 

 

48. Click the Column Width list item. 

 

49. Enter the desired information into the Column width field. Enter "8". 

50. Click the OK button. 
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Step Action 

51. Resize Rows 
Point to the border between rows 2 and 3. 

52. Press the left mouse button on the border line and drag the mouse down until the 

row is the desired width. 

53. Align Column Headers 
Highlight the A1 thru G2 cells. 

54. Click the Center button. 

 

55. Highlight the A3 thru G59 cells. 

56. Click the button to the right of the Borders field. 

 

57. Click the All Borders list item. 

 

58. Change Number of Decimal Places 
 

Click the G cell to highlight the entire column. 
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Step Action 

59. Click the button to the right of the Format field. 

 

60. Click the Format Cells option. 

 

61. Click the Number option. 

 

 



Training Guide 

 

Human Resources 9.1 Payroll Reporting - HCSD 

 

 Page 54 

 
 

Step Action 

62. Click the Up arrow to change the decimal places to 3. 

 

63. Click the OK button. 

 

64. Freeze Rows/Columns 
 

Click the A3 cell. 

 

65. Click the View tab. 
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Step Action 

66. Click the Freeze Panes option so that column titles will remain displayed when 

scrolling down the page. 

 

67. Click the Freeze Panes option. 

 

68. Sum the FTE Column 
 

Click the Down button of the scrollbar. 

 

69. Enter the desired information into the G59 field. Enter "=SUM(". 

70. Highlight the G3 thru G59 cells. 

71. Enter the desired information at the end of the formula. Enter ")". 
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Step Action 

72. Press [Enter]. 

73. Insert a Column 
 

Click the F cell to highlight the entire column. 

 

74. Right-click in the highlighted cells. 

 

75. Click the Insert option. 

 

76. Enter the desired information into the F2 cell. Enter "Name, Desc, Position". 

77. Concatenate (Merge) Cells 
 

Right-click the F3 cell. 

 

78. Click the Format Cells option. 

 

79. Click the General option. 
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Step Action 

80. Click the OK button. 

 

 

 
 

Step Action 

81. Click the Formulas tab. 
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Step Action 

82. Click the Insert Function list item. 
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Step Action 

83. NOTE: If the Concatenate option does not display in the Select a function section, 

type concatenate into the Search for a function section.  
 

Enter the desired information into the Search for a function field. 

Enter "concatenate". 

84. Click the Go button. 

 

85. Click the OK button. 
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Step Action 

86. For the Text 1 field, click the D3 cell. 

 

87. For the Text 2 field, click the G3 cell. 
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Step Action 

88. For the Text 3 field, click the E3 cell. 

 

89. Click the OK button. 
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Step Action 

90. Insert commas and spaces between the Name, Desc and Position information. 

 

Click in the Formula Bar field. Click behind "D3," in the cell. 

 

91. Place a comma and space between Name and Desc. 

 

Enter the desired information into the field. Enter "","," "," (Quotation mark, 

comma, quotation mark, comma, quotation mark, space bar, quotation mark and 

comma). 
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Step Action 

92. Click behind "G3," in the formula bar. 

 

93. Place a comma and space between Desc and Position. 

 

Enter the desired information into the field. Enter "","," "," (Quotation mark, 

comma, quotation mark, comma, quotation mark, space bar, quotation mark and 

comma). 

94. Press [Enter]. 

95. Copy Formula 
Right-click on the F3 cell. 

 

96. Click the Copy option. 

 

97. Press the left mouse button in the F4 cell and drag the mouse down to highlight cells 

F4 thru F59. 

98. Right-click in the highlighted area. 

 

99. Click the Paste option. 
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Step Action 

100. Hide Columns/Rows 
Press the left mouse button on the D cell and drag the mouse to the right to highlight 

cells D and E. 

101. Right-click in the highlighted area. 

 

102. Click the Hide option. 

 

103. Click the G cell. 

 

104. Click the Home tab. 

 

105. Click the Format button. 

 

106. Click the Hide & Unhide list item. 

 

107. Click the Hide Columns list item. 

 

108. Click the Office button. 

 

109. Click the Print list item. 

 

110. You will click the Print option to print the report.  

 

For training purposes only, do not print the report. 
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Step Action 

111. Press the left mouse button on the C cell and drag the mouse to right to highlight 

cells F and H. 

112. Click the Format button. 

 

113. Click the Hide & Unhide pointer. 

 

114. Click the Unhide Columns list item. 

 

115. The previously hidden columns display. 

116. This completes HCSD_FTE_HCP_ACTIVE Report. 

End of Procedure. 
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LSU_ALPHA_LIST Report 

Procedure 

 
In this topic you will learn how to run the LSU_ALPHA_LIST Report. 

 
 

Step Action 

1. Enter the desired information into the begins with field. Enter "LSU_ALPHA". 
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Step Action 

2. Click the Search button. 
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Step Action 

3. Click the Edit link. 
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Step Action 

4. You will add a column to the existing query. On the Query tab, select record A: Job 

- EE Job History record and check the FTE option. 

 

Click the Query tab. 
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Step Action 

5. Click the Show Fields button for Record A Job - EE Job History. 

 

6. Click the Sort fields alphabetically button. 

 

7. Click the View 100 link. 

 

8. Click the Down button of the scrollbar. 

 

9. Click the Select option for FTE - FTE. 

 

10. Click the Fields tab. 
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Step Action 

11. Click the Add Criteria button. 
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Step Action 

12. Enter the desired information into the Constant field. Enter "5 - character Business 

Unit". 

 

NOTE: In this example the EKLMC BU is used. 
 

 

13. Click the OK button. 
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Step Action 

14. FTE displays as a Record.Fieldname. 

 

Click the Run tab. 
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Step Action 

15. NOTE: Queries should always be run in HTML format first to ensure that all data 

is viewed. 
 

Click the Download to Excel link. 

 

This will open a new window. 

 

16. Click the Open button. 

 

17. NOTE: Employee names, NIDs, Monthly Rates and  Hrly Rates have been 

removed for training purposes only. 
 

Click the Page Layout tab. 

 

18. Click the Print Titles button. 

 

19. Click the Landscape option. 
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Step Action 

20. Click the button to the right of the Paper size field. 

 

21. Click the Legal option. 

 

22. Click the OK menu. 

 

23. The following topics will be demonstrated in this topic: 

• Find and Replace; 

• Sort; 

• Subtotal; 

• Formulas; 

• Add/Delete Sheet; and 

• Add/Delete columns. 

24. Find and Replace 
 

Click the Home tab. 

 

25. Click in the H3 field. 
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Step Action 

26. Click the Find & Select button. 

27. Click the Replace... menu. 
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Step Action 

28. Enter the desired information into the Find what field. Enter "RN 2". 

29. Enter the desired information into the Replace with field. Enter "REG NURSE 2". 

30. Click the Replace All button. 

 

31. Click the OK button. 

 

32. Click the Close button. 

 

33. Sort 
 

Click the Data option. 

 

 

 
 

Step Action 

34. Click the Sort option. 
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Step Action 

35. Click the button to the right of the Sort by field. 

 

 

 
 

Step Action 

36. Click the DeptID option. 
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Step Action 

37. Click the Add Level button. 

 

38. Click the button to the right of the Then by field. 

 

39. Click the Desc option. 

 

40. Click the OK button. 

 

41. Subtotal 
 

Click the Subtotals button. 

 

 



 

Training Guide 
Human Resources 9.1 Payroll Reporting - HCSD 

 

 Page 81 

 
 

Step Action 

42. Click the button to the right of the At each change in: field. 

 

43. Click the DeptID option. 

 

44. Click the OK button. 

 

45. Add a Column 
 

Click the G cell to highlight the entire column. 

 

46. Right-click the highlighted area. 

47. Click the Insert option. 

 

48. Click the G2 cell. 

 

Enter the desired information into the G2 field. Enter "Yearly Rt". 
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Step Action 

49. Formulas 
 

You will multiply the number of hours worked in a year (2080) by the FTE and Hrly 

Rt to calculate the Yearly Rt. 

 

Enter the desired information into the G3 field. Enter "=2080*". 

 

 
 

Step Action 

50. Click the L3 cell. 

 

51. Enter the desired information into the field. Enter "*". 
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Step Action 

52. Click the M3 cell. 
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Step Action 

53. Press [Enter]. 

54. Right-click the G3 cell. 

 

55. Click the Copy option. 

 

56. In the G4 cell, press the left mouse button and drag the mouse down to highlight 

cells G4 thru G96. 

57. Right-click the desired object. 

 

58. Click the Paste option. 

 

59. Click the Office button. 

 

60. Point to the Print menu. 
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Step Action 

61. Click the Print Preview menu. 

 

62. Click the Close Print Preview button. 

63. Page Breaks 
 

Click the 23 cell. 
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Step Action 

64. Click the Breaks button. 

65. Click the Insert Page Break list item. 

 

66. The page break is inserted above line 23 on the worksheet. The page break is 

designated by the dashed line. 

67. Add Sheet 
 

Click the Home button. 

 

68. Click the button to the right of the Insert field. 

 

69. Click the Insert Sheet list item. 

 

70. Click the sheet 1 horizontal tab. 
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Step Action 

71. Click on cell A, press the left mouse button and drag the mouse to the right to 

highlight columns A thru M. 

72. Right-click the highlighted area. 

 

73. Click the Copy option. 

 

74. Click the Sheet 2 horizontal tab. 

 

75. Right-click the A1 cell. 

 

76. Click the Paste option. 

 

77. You may need to resize the columns so that the data will display properly. 
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Step Action 

78. Click the button to the right of the Delete field. 

 

79. Click the Delete Sheet list item. 

 

80. Click the Delete button. 

 

81. Sheet Title 
 

Double-click the sheet 1 horizontal tab. 
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Step Action 

82. Enter the desired information into the sheet 1 field. Enter "ALPHA LIST". 

83. Click the G cell to highlight the entire column. 

 

84. Right-click the highlighted area. 

85. Click the Delete option. 

 

86. Unhide 
 

Click the A cell, press the left mouse button and drag the mouse to the right to 

highlight all columns. 

87. Right-click the highlighted area. 

 

88. Click the Unhide option. 

 

89. This completes LSU_ALPHA_LIST Report. 

End of Procedure. 
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HCSD_FTE_ACTIVE_SUM Report 

Procedure 

 
In this topic you will learn how to run the HCSD_FTE_ACTIVE_SUM Report. 

 
 

Step Action 

1. Enter the desired information into the begins with field. Enter "HCSD". 
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Step Action 

2. Click the Search button. 
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Step Action 

3. Click the HTML link for the HCSD_FTE_ACTIVE_SUM query. 

 

NOTE: This will open a new window. 

 

4. Enter the desired information into the As Of field. Enter "05/27/12". 
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Step Action 

5. Click the View Results button. 
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Step Action 

6. Click the Download to Excel link. 

 

This will open a new window. 

 

7. Click the Open button. 

 

8. Report displays. 

9. This completes HCSD_FTE_ACTIVE_SUM Report. 

End of Procedure. 
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Time & Labor Reports 
When running the Time and Labor reports that require the use of a Run Control ID, you cannot 

use the same Run Control ID to run multiple reports at the same time. Reports should be run one 

at a time. You must wait for the first report to finish running before requesting another 

report to run.  

Time Sheet Audit Report 

Procedure 

 
In this topic you will learn how to run the Time Sheet Audit Report. 

 

Step Action 

1. Click the Main Menu link. 

 

 

 
 

Step Action 

2. Point to the LSUHSC Processes menu. 

3. Point to the Time and Labor menu. 

4. Point to the Report menu. 

5. Click the Time Sheet Audit menu. 
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Step Action 

6. Click the Add a New Value tab. 

 

7. Enter the desired information into the Run Control ID field. Enter "time_audit". 

8. Click the Add button. 
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Step Action 

9. Enter the desired information into the Start Date field. Enter "043012". 

10. Enter the desired information into the End Date field. Enter "050412". 

11. NOTE: All Department codes begin with the two-character BU designation and 

include the seven digit number. 
 

Enter the desired information into the Department field. Enter "EL2036320". 

12. Click the Save button. 

 

13. Click the Run button. 
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Step Action 

14. Click the button to the right of the Server Name field. 

 

15. Click the PSNT option. 

 

16. Click the OK button. 
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Step Action 

17. Click the Report Manager link. 

 

 

  



 

Training Guide 
Human Resources 9.1 Payroll Reporting - HCSD 

 

 Page 101 

 
 

Step Action 

18. If the Status is not Posted, click the Refresh button until Status = Posted and the 

Time Sheet Audit RPT in the Description column turns into a blue link. 
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Step Action 

19. Click the Time Sheet Audit RPT link. 
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Step Action 

20. Click the Close button. 
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Step Action 

21. Click the Go back to Time Sheet Audit Report link. 

 

22. This completes Time Sheet Audit Report. 

End of Procedure. 

 

 

 

 


